Staff Turnitin FAQs

This FAQ is to support staff with their use of Turnitin plagiarism detection software at UCL. Unless stated otherwise these FAQs relate to the use of Turnitin via UCL Moodle. Please refer your students to the Student Turnitin FAQs page.

- **Overview**
  - What is Turnitin?
  - What are the benefits?
  - How do I access Turnitin?
- **How can I set up a Turnitin Assignment?**
  - How can I set up a Turnitin Assignment, step-by-step?
  - How should I plan for and set up anonymous marking?
  - How do I set up Turnitin for drafts, separate from the final submission?
  - Can I put all my Assignments in a single Moodle course area?
- **Plagiarism**
  - How do I view the originality reports and matching text sources?
  - What percentage of the originality score is sufficient to indicate plagiarism?
  - How does Turnitin handle quotes?
  - A piece of work has a similarity score of 0%. No plagiarism?
  - Can I put one student’s work through Turnitin, without putting all students in the class work through as well?
  - Can I submit work on a student’s behalf without them knowing?
  - How can I tell what is in the Turnitin database?
  - Why have students originality scores increased after the due date?
- **Technical**
  - If students resubmit an assignment, won’t it show up as a 100% match?
  - What file formats will Turnitin accept?
  - Will Turnitin accept documents containing images?
  - Will Turnitin accept documents containing equations?
  - What is the maximum file size that can be submitted to Turnitin?
  - How can students minimise the file size of their submissions?
  - Why can’t I mark or add comments to the assignments?
  - How do I bulk download Turnitin assignments?
  - How do I backup Turnitin assignments?
  - How do I reset my Turnitin assignments ready for the next academic year?
  - How do I change the due date of a Turnitin assignment?
  - How do I request to see the source of a matching assignment in Turnitin?
  - I have received a Turnitin ‘Paper View Request’ what do I do?
  - Can I double blind mark work submitted to Turnitin using GradeMark?
  - Why does the Turnitin submission box take so long to load?
  - Can I use Turnitin with Windows 8?
- **Troubleshooting**
  - Why do I get a ‘Read-only’ message when I try and access a Turnitin assignment?
    - How do I change the class from ‘Read only/expired’ to ‘active’?
    - Method 1: How do I change the class from ‘Read only/expired’ to ‘active’ for assignments whose Post date has already passed and anonymity has been lifted?
    - Method 2: How do I change the class from ‘Read only/expired’ to ‘active’ for courses that contain assignments that must maintain anonymity?
  - Why do I get an error when I bulk download Turnitin assignments in Moodle?
  - Why do I get an "unable to download page" error when I try to download a Turnitin assignment from Moodle using Internet Explorer 8?
I get a notice about duplicate copies of a Turnitin assignment with a link to another Turnitin assignment. How do I fix this?

Why do grades I enter in GradeMark not appear in the Submission inbox?

Why can't I (or some of my students) see the Turnitin assignments?

Why won't a student's renamed assignment submission display the new title?

Why are some of the assignments in my submission inbox appearing twice?

When I click on the pencil icon to view or grade a submission, I get a notice 'Loading error: This paper is not available. M14: 11'

Why are students sometimes getting email receipts from Turnitin when they haven't submitted anything?

How do I allow students to submit scanned work or images to Turnitin?

I click on the bin icon to delete a student's submission, but nothing happens?

Helping Students

If the assignment is set to Anonymous, how can I contact students who haven't submitted?

How do I submit an assignment on behalf of a student?

How do students upload an assignment / dissertation to Turnitin?

How do students view their Turnitin assignment grade and feedback in Moodle?

How do students resubmit their assignments?

Do students receive an email notification on the Post Date?

Overview

What is Turnitin?

Turnitin is a third party tool, hosted externally and integrated with Moodle. It has a number of possible uses in different combinations here at UCL.

- to support students in developing their academic writing, including how to use and reference sources;
- to help detect poor academic writing practice, including plagiarism, when it does occur;
- as one alternative via Moodle to manage all stages of the assessment process, including submission, marking and returning work;
- to provide legible and contextualised feedback which students can refer to in future work. These can be 'bubble comments', and/or from a set of frequently-made comments, and/or an optional recorded spoken message.
- for record keeping (both for students and staff).

Find out more about Turnitin...

[Back to top]

What are the benefits?

Turnitin is most helpful when it is used to streamline assessment procedures, give and receive feedback and support good academic writing. The full benefits of all forms of e-assessment becomes apparent when the process is entirely digitised, without requiring paper copies.

Benefits which Turnitin shares with other forms of e-assessment are:

- provision of feedback which is typed and therefore legible (this overcomes a major obstacle preventing students taking up feedback);
- provision of a record of feedback available to students online in a timely way, encouraging them to consult it for future work;
- the goodwill of students who no longer have to travel and queue to submit work;
- many support staff hours saved from receiving, sorting, allocating, and posting scripts to assessors and examiners;
• assessors no longer have to wait for the post - this either gives them a longer period in which to mark or it reduces the marking lead time;
• automation of record keeping, reducing the burden on office staff;
• ability to download and mark offline;
• easier access to scripts in the event of a query;
• a saving of space allocated to storing paper copies.

Benefits specific to Turnitin:

• anonymous submission (as of summer 2013, Moodle too will offer anonymity in its Assignment tools)
• contextualised feedback in the form of 'bubble comments', which are attached to the part of the work they pertain to;
• marking directly onto the script without needing to save or upload files;
• an integrated summary audio comment tool which is very easy to use;
• the ability for staff to see whether students have looked at their feedback;
• an Originality Report highlighting parts of a student's work which match other sources, based on a wide-ranging (though not exhaustive) search of digitised publications and work submitted by students.
• students have the opportunity to submit draft work and obtain their own confidential Originality Report which helps them to understand quoting, paraphrasing, and referencing. It can flag inaccurate quoting, over-quoting, patch writing, and other poor practice.

How do I access Turnitin?

Via Moodle. Staff set up Turnitin Assignments in the appropriate Moodle course area, and give students the necessary guidance about how to use them.

For students a confidential self-check is available in the Moodle area titled 'Plagiarism and Academic Writing'.

[Back to top]

How can I set up a Turnitin Assignment?

How can I set up a Turnitin Assignment, step-by-step?

See our step-by-step guidance to setting up Turnitin Assignments in your Moodle area.

[Back to top]

How should I plan for and set up anonymous marking?

See separate guidance in conjunction with the relevant sections of Miniguide M09.

How do I set up Turnitin for drafts, separate from the final submission?

This is straightforward - but the important thing is to avoid students' work being checked against itself - this would necessarily yield a very high or 100% match.

So, set up a separate Turnitin Assignment as outlined in the step-by-step instructions above and make sure that in its settings you set Store Student Papers to No Repository.

This means that student submissions

• will be checked against papers stored in Turnitin and other material on the Internet;
but won’t themselves be stored in Turnitin.

Can I put all my Assignments in a single Moodle course area?

Sometimes departments are tempted to located all Assignment submissions in a single Moodle course area. Below, we attempt to convince you not to do this. This may work well from an administrative point of view, but if we look at this set-up from the markers’, students’ and technology’s point of view, it’s a different story.

For the following reasons, Digital Education cannot offer support to departments whose problems arise due to using a single Moodle space for assignments from across the department. We simply do not have sufficient resource to support this practice.

Below is a summary of the reasons.

1. Potentially very slow page load times as Turnitin pulls in data for every student in the Moodle area. This is true for the Moodle area front page, and for each Turnitin instance, which has to load data for a massive cohort every time.

2. If the Assignment isn’t in the course area, how will students know/remember it exists and be reminded of their deadlines? Moodle won’t be able to help you remind them because there won’t be link to it in the course’s Activities block, or Calendar, or Upcoming Events. It will look as though there are no assignments set up for that module - because there aren’t, they’re in a central area. This subverts the aspects of Moodle course areas designed to be student-friendly, and instead turns Moodle into something arcane and difficult at the student face.

3. During the submission period students’ personal Moodle Calendar page (if enabled) will become bloated with irrelevant information about other students’ Assignment deadlines. The page will load more slowly. Students are consequently prone to become disaffected with Moodle’s Calendar and stop looking at it, missing the relevant information.

4. Students’ Gradebook - the record of their feedback and marks which ideally is available for them to feed into future work - will be similarly bloated with irrelevant information and its page will load more slowly. These things combined will militate against students actually using the feedback their markers have taken the time and effort to give them.

5. Students may be disorientated, since the information they need to succeed in their assignment (e.g. criteria, readings, notes) is likely to be on that course’s own learn.gold page, not on the central page. And if it is on the central page, that means it must either be duplicated for the course area (extra maintenance each time it changes) or there needs to be an explicit signpost to it from the course area. Students are prone to disorientation - this comes out very strongly from our evaluations.

6. Another cause of disorientation, students won’t be able to use the Navigation bar to return to the front page of their course area - they will have to navigate via their My Home page.

7. Teachers’ view of the Gradebook will be inundated with irrelevant entries for other colleagues’ students and assignments. It will be very slow to load, and they will spend a lot of time scrolling through the superfluous information. In addition they will not conveniently be able to see which of their students have submitted, and which haven’t. Yes, somebody could set up Groups to mitigate this - but that’s an extra thing to do.

8. Many Students submitting to a single course area increases the likelihood of submitting to the wrong Assignment by mistake. If using Turnitin, any assignments submitted to the wrong inbox need to then be checked and then manually unmatched by department staff, to avoid a high percentage being returned incorrectly in the originality report.

9. What about linking directly from a module Moodle area to the precise location of the particular Turnitin assignment? That might help students find their assignment but it doesn’t change the fact
10. Many in a Tutor role marking in a single course area increases the likelihood of mistakes e.g. if editing the grades directly in the Gradebook.
11. The shared Moodle area will have a huge cohort of students. This makes it difficult to check who has submitted against who should have submitted and take measures accordingly. Enabling blind marking / anonymity exacerbates this.
12. Inefficiencies and confusion with External Examiners - who may need to take their own samples of marked work - being presented with irrelevant records in the Gradebook.
13. In some cases it increases the possibility of enrolment errors - a student may be successfully enrolled on the 'main' course, but only find out at the last minute that they don't have access to the 'submission' course.
14. The Portico Enrolment block is not designed to accommodate large numbers of individual modules; after a certain number (varies according to the number of parameters in each record) it simply refuses to take any more.
15. In cases where a wide net is cast, with staff enrolling students from across a department including students who are not actually due to take the assessments, the irrelevant Moodle space displays in students' My Courses page and can be extremely confusing.

Digital Education understands the pressures on staff which make it tempting to put all Assignments in one place. But the fact remains - this doesn't work well for markers, students or Moodle. Talk with Digital Education about alternatives which recognise that staff and students need to protect their time and balance competing needs.

[Back to top]

Plagiarism

How do I view the originality reports and matching text sources?

Instructor QuickStart: Part 3 from Turnitin on Vimeo.

Read step-by-step instructions on using the originality reports here...

What percentage of the originality score is sufficient to indicate plagiarism?

The Similarity Score, expressed as a percentage match, simply indicates the proportion of text in a submission which matches text elsewhere. Detecting similarity is what Turnitin does, but similarity isn't the same thing as plagiarism - similarity can be entirely legitimate. It can reside in quotations, or in the language of a discipline. Work may have a high score because its author lacks confidence or knowledge and has over-quoted as a consequence. Work may have a low score but have used somebody else's idea or phrase without attribution - this becomes an even more significant concern if that idea is central to the work. For these reasons, it's impossible to point to a definitive threshold.

That said, a very high score means that the student's own words and original ideas are proportionally less. The principle of essay writing is that students need to evidence or illustrate their points with well-chosen quotations, but the more of their own ideas, expressed in their own words, they get into their work, the more chance they have to earn credit. The important thing is to ensure that ideas and quotations used are properly referenced in an appropriate academic style, not to aim for a particular similarity score.

[Back to top]

How does Turnitin handle quotes?

that Turnitin has to load huge amounts of irrelevant student data, meaning the page still loads very slowly.
You can set up a Turnitin assignment to exclude quotes, or you can filter these out when viewing the submission. However, it is important to note that Turnitin will consider quoted material to be anything within double quotation marks only ("), anything within single quotation marks (’) will not be considered a quotation. This can cause problems as the Harvard system of referencing, which is commonly used at UCL, requires double quotations for direct speech and single quotations for direct text. This means that a human eye will still be required to check references are accurately given at the end of quoted text at which point they can then be disregarded. Turnitin is a text matching system based on a computerised algorithm and not a judgement engine, so human interpretations of results are always required regardless of quotes materials.

A piece of work has a similarity score of 0%. No plagiarism?

No, a Similarity Score of 0% does not guarantee originality. Turnitin uses a large database of web sites, books, journal articles and other sources, but does not (and cannot) include everything ever written. Although Turnitin can help with highlighting areas of poor academic practice, it can't substitute for academic knowledge and judgement.

Can I put one student's work through Turnitin, without putting all students in the class work through as well?

No, all students in the class must use the same submission method to ensure fair treatment. All papers should be treated equally throughout the submission process.

Can I submit work on a student's behalf without them knowing?

No, students must be informed of the method of submission. If you wish to run the papers through Turnitin after receiving them from a different submission method then students must be informed. Usually, they are informed of the submission method in the handbook for their module/programme.

How can I tell what is in the Turnitin database?

Details of what Turnitin checks against.

If you would like to check if a particular book or journal is in the Turnitin database then you can check this on the iThenticate website.

Why have students originality scores increased after the due date?

Instructors have the option to allow students the ability to resubmit papers to an assignment and get updated Originality Reports for the newly submitted drafts (e.g. the assignment must be set to “Generate Originality Reports for student submissions: immediately (can overwrite report until due-date).” The report that is immediately generated and provided to the student (i.e. "before" the due date of the assignment) does NOT include matches to other student papers in the SAME assignment. Before the assignment due date passes, the report only includes matches to existing student papers on the Turnitin database, journals and publications, and internet sources. The Originality Report is completely and automatically re-generated for ALL papers in the assignment after the due date has passed, thus comparing papers between students in the *same* class/assignment. This may result in the Similarity Index (percentage),
displayed to the student at the time of submission, to be different to that which is displayed after the due
date has passed. For example, if a student had collaborated with another student in the same
class/assignment, there would be a match between those papers, so the percentage may increase.

If late submissions have been allowed to be made after the due date of the assignment, the late-submitted
paper will be added to the database immediately. The report generated for that late submission *will*
search every other paper already submitted to the assignment (i.e. the papers submitted on-time). The
assignment will *NOT* regenerate reports for the already-submitted papers just because a student
submits late. So, the reports for the "submitted-on-time" papers will not consider or include the
late-submission in their assessments.

[Back to top]

If a student's Similarity Index is very high because they submitted to Turnitin portals on 2 courses,
what can I do?

Unfortunately, although tutors and course admins enrolled on a Moodle module site can delete a student's
submission from a Turnitin submission portal, if either portal is set up to store submissions for comparison
with future submissions, then the similarity report for the second submission of the same paper to a
Turnitin portal on a different module site, will include a match to the first submission of this paper.

Only Turnitin can permanently remove items from its repository so that they are not used for future
comparisons. Hence, we would need to submit a request to Turnitin for this to be done which could take
some time.

For a quick fix, you can simply exclude (i.e. filter out) the student's own submission with which the
submission to the correct portal is matched. See Turnitin's guide to excluding sources.

A crafty way of eliminating the high similarity index appearing on one of two submissions of the same
paper would be to:

1. Upload any arbitrary text based document (with more than 20 words) on behalf of the student to the
   Turnitin assignment submission portal that s/he submitted to by mistake. This submission would
   overwrite the last one and in effect remove it from Turnitin's repository. (You would need editing
   permissions on both module sites).
2. After doing this, upload the correct submission AGAIN to the correct Turnitin assignment
   submission portal. 24 hrs or so thereafter, you will see a new similarity index that won't include a
   match to the same piece of work.

[Back to top]

Technical

If students resubmit an assignment, won’t it show up as a 100% match?

No, work submitted within a single assignment by a particular student will never match another
submissions within the same assignment made by the same student. An assignment will only match work
by the same student across multiple assignments (unless you have set it up as a draft assignment to not
submit work to Turnitin).

[Back to top]

What file formats will Turnitin accept?

Please refer to Turnitins guidance on accepted file formats.
Will Turnitin accept documents containing images?

Turnitin only accepts documents containing images if those documents also contain some text.

Will Turnitin accept documents containing equations?

As long as students use Word (with Microsoft Equation) to create their documents, Turnitin should have no trouble displaying their assignments. Word is available to all UCL students free of charge via WTS: http://www.ucl.ac.uk/isd/students/windows/wts/access

What is the maximum file size that can be submitted to Turnitin?

* *The maximum file size is approximately 20MB for v1 and 40 MB for v2, though tutors may choose to reduce this for an individual assignment.

How can students minimise the file size of their submissions?

It may be necessary to compress a document so it is small enough to be uploaded to Turnitin. This is especially true for long documents (such as dissertations) and documents that contain many images.

Saving Word documents to PDF format will often compress the document to a small size, but if your file is still above the maximum upload limit you can follow these instructions to compress the PDF further.

To compress or minimise the file size of large PDF documents:

On a PC:

If you don't already have software to compress PDF documents you can install the following free software and then follow the steps below.

1. Download and install PDFCreator from pdfforge.
2. Launch the PDFCreator.
3. **Drag your document on to the PDFCreator window** OR click Document > Add and locate and open the file (change "postScript files (.ps)" to All files (. in the bottom, right to see your documents).
4. Click OK when the message appears saying: "It is necessary to temporarily set PDFCreator as default printer".
5. Click save.
6. Change the filename if you want to retain the original uncompressed version.
7. Once the file has finished compressing the default printer will be changed back and the compressed PDF file will open.

On a Mac:

1. Open the PDF in the *Preview *application.
2. File > Save As...
3. In the Quartz filter drop-down menu choose 'Reduce File Size'.
4. If you want to keep the original uncompressed version, change the file name.
5. Click Save.
**Why can't I mark or add comments to the assignments?**

If you can't add comments to or grade assignments, this is usually caused by the Post date having been reached. The **Post Date** is the date students receive their feedback and marks and anonymous assignments become un-anonymised.

To mark or add comments you need to change the Post Date to a date in the future:

1. Click on the assignment name in Moodle
2. In the **Summary** tab click the **pen icon** on the right.
3. Change the Post date to a date in the future.
4. Click the tick icon to save the change.

You should now be able to mark and comment on assignments.

**How do I bulk download Turnitin assignments?**

It is now possible to bulk download Turnitin assignments from within Moodle. You can bulk download the original files, PDF versions of the original files and grades (along with the matching scores). You can also download the papers along with the feedback you have provided using Grademark from within Moodle.

**If you are trying to download after the post-date:**

1. Click on the assignment name in Moodle.
2. In the Summary tab you will see 3 file icons in the Export column:
   - **Word icon** - downloads the original file (usually either Word or PDF formats).
   - **PDF icon** - downloads a PDF version of the original file.
   - **Excel icon** - downloads a spreadsheet containing each student's assignment grades and the overlap scores (or similarity match score).
3. When the **Download File** page has loaded, click on the link to download the assignments in zipped file format.
4. To unzip, locate the* turnitinuk_zip_download* file on your computer and follow the instructions below for the operating system you are using:

  **Windows XP**
  1. Right-click on the file and choose **Extract All...**, then click **Next**, **Next**, **Finish**.
  2. A new folder with the same name will appear containing all the assignment files.

  **Windows 7**
  1. Right-click on the file and choose **Extract All...** and click **Extract**.
  2. A new folder with the same name will appear containing all the assignment files.

  **Apple Mac**
  1. Double click on the file.
  2. A new folder with the same name will appear containing all the assignment files.

**To download original files, in an anonymous assignment, or before the post-date:**

1. Go to your Moodle course and click on the name of the Turnitin assignment for which you want to bulk download submissions.
2. In the submission inbox click on the first checkbox alongside **Student** to select all the assignments.
3. Click **Download** and then select **Original files**
4. Once the file is downloads you will need to expand it to access all of the original papers (these will
If you would like to download Grademarked papers:

It is possible to bulk download Turnitin assignments with Grademark feedback from within Moodle. Follow these steps to bulk download grademarked assignments:

1. Go to your Moodle course and click on the name of the Turnitin assignment for which you want to bulk download submissions.
2. In the submission inbox click on the first checkbox alongside Student to select all the assignments.
3. Click Download and then Grademark Files.
4. Once the file is downloads you will need to expand it to access all of the grademarked papers.

The individual files will contain any text based feedback you returned to the student via Grademark including Quickmarks, general comments and rubrics.

How do I backup Turnitin assignments?

Because Turnitin assignments are stored in an external system it is recommended that assignments are bulk downloaded at the end of term and securely archived in line with current practice for electronic assignment storage within your department. For undergraduate courses, all submissions made in the course of the academic year will be captured in the Moodle archive. This takes place mid-June. As postgraduate courses have different timetables, not all submissions are captured in archiving process, so we recommend you manually archive your Moodle course to retain submissions, please click here for more information about manual archiving.

How do I reset my Turnitin assignments ready for the next academic year?

1. Navigate to your Moodle course.
2. In the Administration block click on Reset.
3. Scroll to the bottom of the page and click the Select default button.
4. The default option Copy Turnitin Assignments (Create Duplicates, New Turnitin Class) is the only option Digital Education recommends for course resets.

The three Turnitin assignment reset options are described here:

Copy Turnitin Assignments (Create Duplicates, New Turnitin Class)
This will create a new Turnitin class and a new assignment within the class for the assignment link in Moodle. The old class and assignment will remain associated with the Moodle editors’ Turnitin accounts, so can still be referred to in future via Turnitin and the Moodle archive. This is the most appropriate option for a new cohort of students (e.g. a new class).

Replace Turnitin Assignments (Replace Assignment Parts, Reuse Turnitin Class)
This will add a new assignment in the same Turnitin® class and removes the pre reset assignment from view in the class. This option does not create a new class, so the students from the previous year would have access to this new assignment.

Leave Turnitin Assignments Untouched
This will leave the assignment link in its current state and not remove any associated users. This would mean that when students are removed from the Moodle course during a reset their submissions in the Turnitin® assignment will still be displayed as non enrolled users, hence not really resetting the course properly. You will need express permissions from students to retain their work in this manner.
How do I change the due date of a Turnitin assignment?

1. Go to the Turnitin assignment in Moodle.
2. Click on the Summary tab.
3. Click the edit (pencil) icon.
4. Select a date and time for each setting:
   - **Start date:** when the students can start submitting
   - **Due date:** when the students should submit by
   - **Post date:** when the students will receive their marks and the names of students are revealed for anonymised assignments (must be after the Due date)
5. Click the tick icon to save the dates.

How do I request to see the source of a matching assignment in Turnitin?

1. Go to the Turnitin assignment in Moodle.
2. Click on the Submission Inbox tab.
3. Click on the similarity score (shown as a % with a coloured bar alongside it)
4. Click on the highlighted text in the document that shows a match to another source.
5. Click on the name of institution the matching assignment was submitted to (e.g. Submitted to University College London)
6. A note will appear explaining that you need to request this document from the author's instructor.
7. Click [send a request to view this paper] to submit the request.
8. An email will be sent to all instructors connected to that assignment in Turnitin. For an assignment submitted to UCL Moodle that means all course administrators and tutors will receive the request via email.
9. If the request is accepted you will receive the paper to your UCL email account. The document will be sent in plain text within the body of the email.

I have received a Turnitin 'Paper View Request' what do I do?

When an instructor receives a 'Paper View Request' email from another instructor who is also using Turnitin.

For example, an instructor from another Institution, has a report for one of their students showing a match to a paper that was uploaded to one of their courses.

When an instructor receives one of these requests, they can choose reply to the email, which would give the 'requesting' instructor a copy of the matching paper. But they are not required to reply. They can just ignore the request if they choose. We leave that decision to the Instructor who received the request.

If the instructor replies to the email, the 'requesting' instructor will only get a copy of the matching paper. They receive no other information regarding the student or the instructor.

Can I double blind mark work submitted to Turnitin using GradeMark?

There is no way to double blind mark using GradeMark in Turnitin. One way to double mark using GradeMark is to put initials such as M1 and M2 next to comments made by each marker. However, this is not blind as the markers will be able to see the previous markers comments. Students will be able to see these comments when their marks are released, unless they are deleted first.
Why does the Turnitin submission box take so long to load?

The submission inbox can take time to load as it has to synchronise data with the Turnitin servers and check all of the originality reports. This is a particular problem when there’s a high number of students enrolled on a Moodle course. There are two ways to reduce the loading time, either preventing the submission inbox from auto refreshing or setting up multiple inboxes.

To prevent the submission inbox from automatically refreshing each time you enter it, go into the Turnitin assignment and then click the ‘Options’ tab (located next to the Submission Inbox tab). Located the ‘Auto refresh Grade/Score’ setting, and from the drop down menu (which should be set to ‘Yes, automatically refresh originality scores and grades’ by default) select ‘No, I will refresh originality score and grades manually’. Once you have done this you should click ‘Save Changes’.

NB This will change the setting for the submission inbox for everyone using it. Make sure that other tutors/administrators know to click ‘Refresh Table’ at the top of the submission table to refresh the grades/originality reports.

If you set up multiple inboxes then ensure there are no more than 100 students submitting to one submission inbox. You will also need to set up a new Turnitin assignment for each inbox, and clicking the duplicate button will simply produce multiple links to the same inbox.

Can I use Turnitin with Windows 8?

Windows 8 is currently unsupported by Turnitin. Advice to users is to use Internet Explorer in conjunction with Windows 8 for best performance.
Firefox and Chrome do not allow the marker to select text to make comments.

Troubleshooting

Why do I get a ‘Read-only’ message when I try and access a Turnitin assignment?

This may be due to one of the reasons below:

1. Every Turnitin class (moodle course with Turnitin assignments) has an end date. This is usually 6 months after the Post date of the latest assignment in the Moodle course. When the end date is reached, the assignments on the course expire and are limited to read-only access. Student’s and Tutors will still be able to view assignments however they will no longer be able to submit papers, peer reviews or mark any of the papers using GradeMark.

2. UCL is nearing its student limit and requires to ‘free up’ user accounts. We will always communicate details about this.

How do I change the class from ‘Read only/expired’ to ‘active’?

There are two ways of doing this depending on the Post date of the assignment you wish to make active.

• If the Post date has passed and anonymity of the assignments has been lifted follow Method 1 below

• If anonymity has to be maintained follow Method 2
Method 1: How do I change the class from ‘Read only/expired’ to ‘active’ for assignments whose Post date has already passed and anonymity has been lifted?

1. Login to Moodle
2. Navigate to the relevant Moodle course
3. Open the relevant Turnitin assignment on the course
4. Edit the Post Date to a date in the future. This will cause the class end date to be extended so the class becomes active again. You should then switch back to the original Post date.

Method 2: How do I change the class from ‘Read only/expired’ to ‘active’ for courses that contain assignments that must maintain anonymity?

Create a new Turnitin assignment on your Moodle course and then delete it immediately. This will make active all the assignments on that Moodle course.

Why do I get an error when I bulk download Turnitin assignments in Moodle?

If you get the following error when you try to bulk download assignments from Moodle, you are probably not specified as a Turnitin tutor for that Moodle course.
Error: 241
The user does not have the specified role in the class.

To add yourself as a Turnitin tutor for assignments on a particular Moodle course:

1. Go to the Turnitin assignment.
2. On the Options tab, click on the edit icon alongside Turnitin Tutors.
3. Under Turnitin Tutors, select your name from the list and click [Add Turnitin Tutor].

You should now be able to bulk download Turnitin assignments.

Why do I get an "unable to download page" error when I try to download a Turnitin assignment from Moodle using Internet Explorer 8?

This is a known issue with Internet Explorer 8 with no available workaround. Please use Firefox instead or upgrade to Internet Explorer 9.

I get a notice about duplicate copies of a Turnitin assignment with a link to another Turnitin assignment. How do I fix this?

If you restore a backup containing Turnitin assignments or import them from a Moodle course you will see the following warning message:

Duplicate copies of the same Turnitin assignments were found, duplicates occur when one or more Moodle Direct assignment is connected to the same one Turnitin assignment via the Turnitin API. This is known to cause issues, most notably submissions made to one of the duplicates will show up in the submission inbox of the others. To fix this you should either delete the duplicate assignments or reset the course where the duplicate assignments are.
The following duplicates were found:

Notice

To fix this you need to either:

1. Remove one of these assignments. You can recreate a new Turnitin assignment manually to replace it if required. OR
2. Reset your course (with only the default Turnitin reset option selected!) so that Turnitin copies all the assignments on the course and creates new ones. NOTE: *DO NOT do this if you have any current assignments with submissions* anywhere in the course. After you reset, the links to all assignments in the course will be lost and new assignments will be created in their place.

Why do grades I enter in GradeMark not appear in the Submission inbox?

1. Go to your Turnitin assignment in Moodle.
2. Click on the Options tab.
   Check that the Use GradeMark? option is set to* Yes, use GradeMark to grade submissions*.
3. Click Save Changes.
4. Go back to the Submission Inbox.

You will notice that the yellow pencil icon will have changed to a blue pencil indicating that GradeMark is now being used.

Why can't I (or some of my students) see the Turnitin assignments?

The new Turnitin 2 document viewer is not compatible with older versions of Internet Explorer. Use a more recent version of IE8+ or use Firefox instead.

Why won't a student’s renamed assignment submission display the new title?

Sometimes students may not name their submission title correctly (forgetting their candidate number, or including their name for anonymous assignments).

When they next upload their assignment they can rename it (providing this is done before the due date). Turnitin will only display the new assignment title when the next report is generated. As Turnitin will only generate a new report every 24 hours, it may take up to 24 hours for the new assignment title to display.

Why are some of the assignments in my submission inbox appearing twice?

It is possible on occasion, normally due to an error with Turnitin, that assignments within an inbox can appear in duplicate. In this case DO NOT delete either assignment as this will in fact delete both the duplicate and the original. The assignment is not actually duplicated, it simply is displayed as such. To rectify the issue you should display all of the assignments, then filtered by the paper ID. Next scroll down the list looking for duplicates (comparing the final number can be a good way to do this). When you find the duplicate, refresh that assignment by clicking on the refresh icon to the right of it. This will rectify the issue and you should see the number of submitted assignments decrease.
When I click on the pencil icon to view or grade a submission, I get a notice 'Loading error: This paper is not available. M14: 11'

There is currently a bug which will not allow you to access submissions this way. Please click on the title of the submission in the inbox, this will load the paper correctly.

Why are students sometimes getting email receipts from Turnitin when they haven't submitted anything?

If a tutor clicks on the grade pencil icon next to a student's name in a Turnitin inbox when they haven't submitted anything, the student receives an email 'digital receipt' with paper ID. Turnitin are aware of this issue and the Digital Education Services team have asked them to resolve it.

How do I allow students to submit scanned work or images to Turnitin?

Turnitin requires there to be at least 20 words submitted, so if students need to submit scanned work or images you should provide a coversheet containing at least 20 words that students can attach to the start of their scanned PDFs. In order to merge these in to one document students on a PC can use PDFMerge and students on a Mac can use the pre-installed Mac Preview. If you are using Desktop@UCL see: How to merge PDF documents. Note. scanned work or images cannot currently be checked for plagiarism by Turnitin.

I click on the bin icon to delete a student's submission, but nothing happens?

Please clear your browser's cache, this should remedy the problem.

Helping Students

If the assignment is set to Anonymous, how can I contact students who haven’t submitted?

Your Turnitin inbox has a 'Notify Non-Submitters' link, which will send an email to all students yet to submit. This may work best when you allow submissions after the Due Date.

However, sometimes it's hard to reach students with email, and for pastoral outreach to happen a member of staff may need to find out who those students are.

1. Log in and navigate to the Moodle area with the assignment you need to monitor.
2. From the Navigation menu select Reports, and from the Reports sub-menu select Course Participation; the Participation Report page then loads allowing you to filter your search as follows.
   a. From the Activity Module menu, select the assignment you need to monitor.
   b. Choose a period of time to 'Look Back' over.
   c. ‘Show Only’ student reports.
   d. And finally, for ‘Show Actions’ select Post - which will show only students who have uploaded.
3. When you're ready, click the Go button; the results then display.
4. By clicking each column heading, you can sort the results for Post by Yes or No.
5. Once you have identified the students who haven't submitted, the Participation Report gives you the opportunity to select their respective checkbox and send them a message - scroll to the bottom of
How do I submit an assignment on behalf of a student?

Note. Course Administrators and Tutors should try to avoid submitting on behalf of a student.

If the assignment is anonymous, a Course Administrator who is not directly involved in marking the student's submission can request the Turnitin Paper ID number and the submission file from the student. The Turnitin Paper ID appears on the assignment upload page to the student. The Course Administrator can then:

1. Navigate to your UCL Moodle course.
2. Click on the Turnitin assignment to open the Submission Inbox.
3. Find the Turnitin Paper ID as provided by the student.
4. Click the adjacent submit paper upload icon.
5. The student will now see this submission in Moodle as though they had uploaded it themselves.

If the assignment is not anonymous:

1. Navigate to your UCL Moodle course.
2. Click on the Turnitin assignment to open the Submission Inbox.
3. Find the student's name.
4. Click the adjacent submit paper upload icon.
5. The student will now see this submission in Moodle as though they had uploaded it themselves.

How do students upload an assignment / dissertation to Turnitin?

UCL recommend using Turnitin via Moodle, rather than directly, as it is the easiest way to enable multiple staff to access an assignment.

Note: UCL support staff are unable to support direct access to Turnitin.

The student wiki provides guidance for how students submit.

How do students view their Turnitin assignment grade and feedback in Moodle?

To view Turnitin assignment grades and feedback via Moodle students need to follow these steps:

1. Navigate to your UCL Moodle course.
2. Click on the assignment.
3. Click on the My Submissions tab.
4. Your grade will be displayed in the Grade column (alongside the pencil).
5. Click on the pencil icon to view any feedback your tutor has left for you within Turnitin. The right-hand column will display any feedback your tutor has left - you can navigate through the different types of feedback using the 3 buttons below this column:
   - The 'General comments' button is selected by default and will display any comments the tutor has made about your submission overall.
   - Clicking on the second 'QuickMarks' button will show you any in-text comments the tutor has left. Comments within the document (in-text comments) will be also displayed when you place your mouse over the speech bubble icon alongside the highlighted text.
   - The third 'Rubric' button will show you how your assignment was graded against each criteria.
6. To return to Moodle, close down the assignment window.

How do students resubmit their assignments?

Ensure you setup the assignment to accept multiple submissions and generate multiple reports by setting Report Generation Speed to Generate reports immediately, reports can be overwritten until due date.

In the past, students had to delete old submissions before resubmitting. With the new version of the Turnitin plugin they now just upload over the top of their old submission instead.

*NOTE:* Once the due date has passed, students will not be able to resubmit. Only those students who have submitted nothing will be able to submit, assuming you have enabled late submissions in the settings. To allow a student to resubmit after the due date, you will need to delete their existing submission first using the delete (rubbish bin) icon and they can then upload another file.

Do students receive an email notification on the Post Date?

No, there is no automatic notification. If you set the Post Date to the expected Post Date, and stick to that, then students will know (from the Turnitin Assignment's landing page aka Summary) when to check back. Otherwise, tutors can always send a News Forum post saying 'Your marks are now available to view'.

When an instructor receives an email like that, they are receiving a 'Paper View Request' from another instructor who is also using Turnitin.

When a paper is submitted to Turnitin by a student, only that student, and the instructor of the course where the paper was submitted have direct access to that paper. That is part of the Security and Privacy policies that have been set up.

In this case, Iram Sohail, an instructor from Pakistan, has a report for one of their students showing a match to a paper that was uploaded to one of Sanaz Zolghadriha's courses.

When an instructor receives one of these requests, they can choose reply to the email, which would give the 'requesting' instructor a copy of the matching paper. But they are not required to reply. They can just ignore the request if they choose. According to the Product Managers here at Turnitin, we leave that decision to the Instructor who received the request.

If the instructor replies to the email, the 'requesting' instructor will only get a copy of the matching paper. They receive no other information regarding the student or the instructor.

Sometimes we have Instructors who always reply to the emails to help out the 'requesting' Instructor, while other
times we have Instructors who will just ignore these requests. We also have some schools that dictate to their Instructors what to do with these requests. Basically, we leave the decision to the Instructor and the school.